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1 Single Channel Analysis 

This chapter describes how to use a template to perform a Single Channel Analysis. You will learn 
how to: 

 Assign models to components 

 Run the single channel simulations 

 Set up the simulation parameters 

 Set up the simulation options 

What-if scenarios illustrate how results change when there are changes in the data rate and the 
inclusion of equalization via AMI modeling. 

1.1 Overview 
The single channel template contains： 

 One transmitter 

 One receiver 

 Printed-circuit board (PCB) 

 Two packages as shown below 

 
As shown above, two AMI blocks in lighter grey connect to the transmitter and receiver, which are 
disabled by default.  

The single channel template has different meanings for different designs.  
Example 

The PCB block could mean a backplane or an add-in module. 

The Pkg2 block could be a flip chip or an SiP design or even a connector.  

You can define the blocks according to your applications. 

You can modify the template; for example, adding additional blocks which are part of your actual 
channel.  
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1.2 Starting the Single Channel Template 
1. Launch SystemSI. 
2. In the File menu, click New; 

or,  in the Main toolbar, click the New button . 
The Select Module dialog opens. 

 
3. Select Serial Link Analysis. 
4. Click OK. 

The New Workplace dialog for a single channel template opens. You can now create a new 
workspace.  

 
5. Select Create by template. 
 

NOTE! You can also click  to browse to the folder where templates are 
located. 

The paths for the templates are automatically generated during SystemSI installation. You cannot 
modify these paths.   

<INSTALL_DIR>\SpeedXP\Library\template\SystemSI\Serial Link Analysis\single_channel_simple  
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<INSTALL_DIR>\SpeedXP\Library\template\SystemSI\Serial Link 
Analysis\single_channel_complex  

<INSTALL_DIR>\SpeedXP\Library\template\SystemSI\Serial Link Analysis\xtalk_channel  

<INSTALL_DIR>\SpeedXP\Library\template\SystemSI\Serial Link Analysis\measurement_xtalk  

 

NOTE! Do not change the name or location of the template folders. 

 
6. Enter a name for the new workspace, such as sc_example1. 
7. Enter or select a location. 
8. Click OK. 

A folder with the same workspace name will be created in the location. The folder contains 
the workspace file sc_example1.ssix and all models for the transmitter, receiver and other 
channel blocks. You’ll use them to create new workspaces with all component models, 
connectivity and settings. 
 

NOTE! Do not change the contents of any template folders. 

1.2.1 Template Blocks 
The single channel template has the following blocks:  

TX_PRIMARY: A primary transmitter.  

RX_PRIMARY: A primary receiver.  

Pkg1 and Pkg2: Two packages.   

PCB: A printed-circuit board.  

AMI: Two AMI models.   

1.2.2 New Workspace 
The newly-created single channel workspace sc_example1.ssix looks like the following figure. 
You can click to highlight any block or connection in this interface.  
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NOTE! The AMI blocks are enabled by default. Disable them first for the 
following steps of setting. 

1.3 Channel Components 
This section describes each block in the single channel workspace and examines the properties.  

The properties of each block in the Single Channel Template have been set up. You can skip this 
section. Your simulation setup procedure is not affected.   

1.3.1 TX_PRIMARY 
Double-click the TX_PRIMARY block to open the Property pane.  

  
The Property pane of the TX_PRIMARY block contains four tabs:  

 Connection 

 Stimulus 

 Jitter & Noise 

 Power Supply 
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1.3.1.1 Connection Tab 

The Connection tab contains these parts:  

 Block Name 

 Connection List 

 File Name and Sub-circuit Name 

 SPICE Netlist File Content 

1.3.1.1.1 Block Name 

Change the Block Name in the Block Name window.  

 

1.3.1.1.2 Connection List 
The Connection List displays connections between blocks. The TX_PRIMARTY block has a 
connection (tx_pkg) which connects to the Pkg1 block at the DIE side. 

  
Click in the field to highlight the connection.  

 
You can define and manage connections through the Connection Definition tab.  
Click the  button to open the Connection Definition interface, as shown in the 
following snapshot.  

  

1.3.1.1.3 File Name and Sub-circuit Name 

This section specifies the SPICE netlist file name and the sub-circuit model associated with the 
block.  

  



 12 Product Version 16.6 

By default, the Single Channel Template has only one sub-circuit model specified for each block. 
You can choose your SPICE netlist file. Your file might contain several sub-circuit models. 

1.3.1.1.4 SPICE Netlist File Content 

This content of the SPICE netlist file includes sub-circuit calls and an MCP section. The MCP 
section is used to maintain the connections between blocks.  

 
It is recommended that you should not edit the MCP section. Make sure the sub-circuit nodes are 
called properly so that the connections are correct.  

Click  to edit the SPICE netlist file. 
To edit or modify the MCP header, select the Launch MCP Header Editor. 
 

NOTE! Do not edit the MCP section between  and . 
SystemSI needs this section to manage the channel connections.  
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1.3.1.2 Stimulus Tab 

  
 Data Rate (Gbps)  

Specifies the nominal data rate that the system will operate at. For example, PCI Express 2.0 
operates at 5 Gbps.   

The default value is 3.125 Gbps, which is based on the XAUI standard.  

 Data Pattern  

Following stimulus types are available:  

－ Random (Default)  

－ PRBS (up to 100)  

－ User Defined (See User Defined Bit Pattern) 

－ Sinusoidal Waveform 

－ Sawtooth 

－ Clock 

 Leading bits  

One of the ways to change phase alignment during crosstalk simulation. Can also be used 
before the beginning of a bit stream for training pattern. 

 Delay (ns)  

Another way to change phase alignment in crosstalk simulation. Enter a delay in 
nanoseconds. Delay can be positive or negative; referred to as global zero time. Default value 
is 0 ns.  

 Data Coding  

Place statistical bounds on the rate of SignalTransitions, allows for easier clock recovery in 
the receiver, and for DC balance. Disabled by default. 

Available coding types:  

－ 8b10b  

－ 64b66b (Default) 

－ 64b67b 

－ 128b130b 
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 Rise/Fall time (ps)  

Specifies the rise and fall time of the Driver Signal. Disabled by default. 

• Restore Defaults 
Resets the field values to the original values that are displayed on the first launch of the tool. 
For regular templates, all fields, except Data Rate, are restored to their default values. In case 
of compliance templates, all fields are restored to their original values. 

1.3.1.2.1 User Defined Bit Pattern 

You can create your own bit patterns to use with SystemSI. This functionality allows you to point 
to a text file containing the desired bit pattern. For example: 

0101111000110100.. 

The two periods at the end are required for the pattern to be repeated over and over until the 
desired number of bits has been reached. If the two periods are not included, just a short bit stream 
will be run. No post-processed outputs (ex. eye contour) will be generated. 

An example of a bit pattern text file is provided as bit_pattern.txt in the installation directory: 

<INSTALL_DIR>\SpeedXP\Library\template\SystemSI\ 

1.3.1.3 Jitter & Noise Tab 
The Jitter & Noise tab has two sections, Jitter and Noise, and a Restore Defaults button. 

 
Restore Defaults: For regular templates, selecting this button resets all field values to the 
product defaults. In case of compliance templates, all fields are restored to the value saved for 
that particular compliance. 

1.3.1.3.1 Jitter 

 Periodic  

This is one of the principle ways to test Jitter Tolerance. Specify the frequency of the 
sinusoid jitter source in Hz and the amplitude in UI. 

 Frequency Offset (ppm)  

Specifies the deviation from the nominal data rate in parts-per-million or ppm. Default value 
is 100 ppm. If the Bit Rate is 10 Gb/s then the actual rate can be 10 Gb/s +/- 1e6.  
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 Transition Rj   

Applied to each logic transition of the transmitter’s incoming bit stream (i.e. stimulus signal) 
in a Gaussian distribution, out to 8 sigma. 

 Transition Dj   

Applied to each logic transition of the transmitter’s incoming bit stream (i.e. stimulus signal) 
in a rectangular window of equal probability. 

 DCD (%)  

Type of Dj. Describes the deviation in duty cycle value from the ideal value. Can also be 
modeled as an asymmetry between rise and fall time at the transmitter. Default value is 0% 
of the bit time. 

NOTE! Jitter elements are disabled by default. 

1.3.1.3.2 Noise 

 Periodic - Model the Noise that is usually introduced through the reference clock on the 
PLL. Modeled as a sinusoid. Specifies the frequency of the sinusoid Jitter source in Hz and 
the amplitude in % of input voltage swing.  

 Transition (mV) - Type of Dn and it’s applied at each transmitter edge. Default value is 1% 
of input voltage swing. 

NOTE! All noise elements are disabled by default. 

1.3.1.4 Power Supply Tab 

 
 Ideal Power Supply - Ideal voltage source that is used at the transmitter. Default value is 1 V. 

Ideal Power Supply should be defined according to the following rules, or else, the warning 
or error message will appear. 
For ideal power simulation (Ideal Power is checked in the Analysis Options window),  

− If the .sp file assigned to the Tx or Rx does not have its own power supply defined in 
the .sp file, Ideal Power Supply should be enabled in the Property GUI. 

− If the .sp file assigned to the Tx or Rx has its own power supply defined in the .sp file, 
Ideal Power Supply should not be enabled in the Property GUI. 

For non-ideal power simulation (Ideal Power is not checked in the Analysis Options 
window), both the Tx and Rx blocks should get the power supply from the VRM block.  

1.3.2 RX_PRIMARY 
Double-click on the RX_PRIMARY block to open the Property pane. The Property pane 
contains three tabs: Connection, Jitter & Noise and Power Supply. 
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1.3.2.1 Connection Tab 

The Connection tab contains these parts:  

 Block Name 

 Connection List 

 File Name and Sub-circuit Name 

 SPICE Netlist File Content 

1.3.2.1.1 Block Name 
Change the Block Name in this field.  

 

1.3.2.1.2 Connection List 
This pane displays the connections between the blocks.   

 
The connection listed above shows the rx_pkg connects to the Pkg2 block at the DIE side.  

 
You can define or manage the connections in the Connection Definition tab.  

To open the Connection Definition tab, click on the  button or double-click on the 
highlighted connection. The Connection Definition tab opens. The connection names and 
connection nodes are displayed. Any broken connections are indicated.  

1.3.2.1.3 File Name and Sub-circuit Name 
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This section specifies the SPICE netlist file name and the sub-circuit model associated with the 
block.  

 
By default, the Single Channel Template has only one sub-circuit model specified for each block. 
You can choose your SPICE netlist file. Your file might contain several sub-circuit models. 

1.3.2.1.4 SPICE Netlist File Content 

Please refer to Section 1.3.2.1.4 SPICE Netlist File Content for details. 

1.3.2.2 Jitter & Noise Tab 
The Jitter & Noise tab has two sections: Jitter and Noise. 

 
 Random Jitter (Rj) (%)  

Jitter has not been bounded. Random jitter is described by a Gaussian probability distribution, 
characterized by its standard deviation (RMS) value. This type of jitter is caused by thermal 
noise or other random noise effects in the system. Default value is 1% of the bit time.  

 Deterministic Jitter (Dj) (%)  

Jitter with a non-Gaussian probability density function. Jitter is always bounded in amplitude 
and with specific causes. Default value is 1% of the bit time.  

 Random Noise (Rn) (mV)  

Caused by random fluctuations in signal voltage. Default value is 1 mV.  

 Deterministic Noise (Dn) (mV)  

Comes from power supply. Can have many sources such as capacitive and inductive 
coupling. Default value is 1 mV. 

Rj, Dj, Rn and Dn are all post-processed jitter and noise. They show up in the Bathtub 
curve, which is a cumulative distribution function. Other types of deterministic jitter are 
added to the Transmitter Bit Stream, such as: 

 periodic jitter 

 DCD 
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 Duty Cycle Distortion. 
 

 Restore Defaults 

For regular templates, Selecting this button resets all field values to the product defaults.in 
case of compliance templates, all fields are restored to the value saved for that particular 
compliance. 

1.3.2.3 Power Supply Tab 

 
 Power Supply - Ideal voltage source that is used at the transmitter. Default value is 1 V. 

Please refer to Section 1.3.1.4 Power Supply Tab for details. 

1.3.3 Pkg1 
Double-click the Pkg1 block to open the Property pane. 
The Property pane contains two tabs: Connection and Layout Extraction. 

 

1.3.3.1 Connection Tab 

The Connection tab contains these parts:  

 Block Name 

 Connection List 

 SPICE Netlist File 

1.3.3.1.1 Block Name 

 
Change the Block Name in this field. 

1.3.3.1.2 Connection List 
This pane displays the connections between the blocks. 
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The Pkg1 block has two connections:  

－ From Pkg1 to TX_PRIMARY, through the DIE connection.  

－ From Pkg1 to PCB, through the BGA connection. 

1.3.3.1.3 SPICE Netlist File 

 

1.3.3.2 Layout Extraction Tab 

 

1.3.4 Pkg2 
The difference between Pkg1 and Pkg2 is in the connectivity and the model name. Both use the 
same package model. 

Double-click on the Pkg2 block to open the Property pane. The Property pane opens and 
displays the Pkg2 tabs. 

The single channel template used here has dummy models for Pkg1 and Pkg2 blocks. So there is a 
short circuit between PCB and TX_PRIMARY blocks, and PCB and RX_PRIMARY blocks. 
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1.3.5 PCB 
Double-click on the PCB Block to open the Property pane: 

 
The Connection tab contains these parts. 

 Block Name 

 Connection List 

 SPICE Netlist File  

1.3.5.1 Block Name 

Change the Block Name in this field. 

 

1.3.5.2 Connection List 
The Connection pane shows the connections between the blocks. 

 
The PCB block has two connections:  

－ From PCB to Pkg1, through the BGA connection.  

－ From PCB to Pkg2, through the BGA connection. 

1.3.5.3 SPICE File List 
The model used by the PCB block is a 4-port s-parameter file. You can replace the file with:  

 Another S-parameter File 

 A W-element model 

 Other Circuit Elements 
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• View S parameter 

Select this button to review the s-parameters for a block in the s-parameter viewer window. 

• Extract BBS Model  

Select this to launch Broadband Spice and generate a BBS model for the S Parameter or 
Touchstone file 

• Load BBS Model  

For subcircuits with an S Parameter model, use this button to load the BBS model (generated 
by Broadband spice for the S Parameter or Touchstone file). 

• Launch MCP Header Editor 

Select this to invoke the MCP Header Editor. If the Touchstone file or the BNP files do not 
have the MCP header information, you need to manually add it  in MCP Header Editor.  

• Edit sub-circuit Definition 

Select this to open the .sp file in sub-circuit Definition Editor for editing. 

1.3.6 AMI 
AMI stands for Algorithmic Modeling Interface. It is designed to model advanced 
Serializer/Deserializer (SERDES) devices. All models contain complex signal processing routines 
that are compiled into separate executables (DLL files) that are called by the channel engine. AMI 
contains three functions： 

 AMI_Init 

 AMI_GetWave 

 AMI_Close 

－ SystemSI - Serial Link Analysis first characterizes the channel by means of an impulse or 
step response, and then calls the AMI DLL files to apply equalization to the channel.  

Related Topic 
·Refer to: http://www.vhdl.org/pub/ibis/birds/ 

http://www.vhdl.org/pub/ibis/birds/
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1.3.6.1 Transmitter AMI 

To open the Property pane, double-click on the AMI block connected to the transmitter.  

 
The AMI property pane contains two sections: 

 AMI parameter and DLL file locations 

 AMI parameter list 

The AMI parameter list contains two tabs: 

• Model Specific  

• Reserved Parameters 

1.3.6.1.1 AMI Parameter and DLL File Locations 

 
 AMI parameter file - Contains all AMI parameters such as Forward tab, Precursor tab 

and tap Coefficient, as well as usage definitions of those parameters.  

 AMI dll file - Library file represents the AMI model in an executable format and is called 
by the channel engine. 

 

NOTE! 
When installing the Channel Analysis tool, a template directory is 
created with all the template files, as well as a new folder called 
amiwin. That folder contains all the AMI models.   
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1.3.6.1.2 AMI Parameter List – Model Specific 

 

1.3.6.1.3 AMI Parameter List – Reserved Parameters 

 
Generally, you can edit the AMI parameters from the AMI Parameter Editor as shown below. 

 
Some reserved parameters are not editable or supported in SystemSI.  

• If you try to edit the following reserved parameters Max_Init_Aggressors, 
Init_Returns_Impulse, or GetWave_Exists, the values are not editable in the AMI 
Parameter Editor dialog box.  
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• If you try to edit TrainOn, the following message will be issued. 

 
• The reserved parameters Tx_Jitter and Rx_Clock_PDF are not supported by SystemSI, 

as post BIRD 123 they are obsolete. 

If an AMI file has any of these parameters, a message will be issued when it is loaded to 
SystemSI.  
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1.3.6.2 Receiver AMI 

To open the Property pane, double-click on the AMI block connected to the receiver.  

 
The AMI property pane contains two sections:  

 AMI parameter and DLL file locations 

 AMI parameter list 

The AMI parameter list contains two tabs: 

 Model Specific  

 Reserved Parameters 

1.3.6.2.1 AMI parameter and DLL File Locations 

 

1.3.6.2.2 AMI Parameter List – Model Specific 

 

1.3.6.2.3 AMI Parameter List – Reserved Parameters 
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Please refer to Section 1.3.6.1.3 AMI Parameter List – Reserved Parameters for details. 

1.3.6.3 AMI Options 
You can choose Setup > AMI Options to check the AMI options. 

 
• If any AMI files has any Jitter and Noise parameters (as listed below) as the Reserved 

Parameters, AMI Options > Jitter & Noise of Tx and Rx Blocks can be turned on or off. 
Otherwise, it is turned on and grayed out. 

− Tx_Dj 

− Tx_DCD 

− Tx_Rj 

− Tx_Sj 

− Tx_Sj_frequency 

− Rx_Rj 

− Rx_Dj 

− Rx_Sj 

− Rx_DCD 

− Rx_Clock_Recovery_Mean 

− Rx_Clock_Recovery_Rj 

− Rx_Clock_Recovery_Dj 

− Rx_Clock_Recovery_Sj 

− Rx_Clock_Recovery_DCD 

− Rx_Noise 
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• If any AMI files has the Reserved Parameter TrainOn, AMI Options > Back-Channel 
can be turned on or off. Otherwise, it is turned off and grayed out. 

• When loading an AMI file, if the AMI has any Jitter and Noise parameters (as listed 
above) as Reserved Parameters, and AMI Options > Jitter & Noise of Tx and Rx Blocks is 
turned on, a dialog will be issued asking a question. 

 
If you click the Yes button, AMI Options > Jitter & Noise of Tx and Rx Blocks will be 
turned off automatically. 

1.4 Analysis Options 
To open the Analysis Options interface, start in the Setup menu and click Analysis Options…. 

 
The Analysis Options pane opens. 

 
The Analysis Options interface has two parts:  
 Simulator 
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It includes Circuit Simulator, Circuit Simulator Options/Channel Simulator Controls, 
Channel Simulator OS, and Simulation Name. 

 Analysis Setup 
It includes Ignore Time, # of Bits, Bit Sampling Rate, BER Floor, Simulation 
Configuration, XTalk, Eye Distribution, BER_Eyes, and IBIS Model Selection. 

1.4.1 Simulator 

1.4.1.1 Circuit Simulator 

 
You can specify the circuit simulator that will be used in the Time-Domain Simulation to 
characterize the channel via the step response. 

There are two simulators available: 

 
 Specify the path for HSPICE executable file in the HSPICE text field.   

 SPDSIM is a built-in circuit simulator. It is a SPEED2000 simulator.   

For the Characterization part: 

 Duration refers to the duration of the Characterization run with the specified Circuit 
Simulator. The Characterization should be run long enough to allow any reflections to settle 
out, and the waveforms reach their steady state. 

 Vmeas refers to the voltage threshold at which delay is measured from the Characterization. 
This information is included in the Channel Report as Delay. If Vmeas value is not explicitly 
called out in an IBIS file associated with the Tx block, Vmeas is taken as the midpoint of the 
voltage swing seen in the Characterization waveform. 

1.4.1.2 Circuit Simulator Options/Channel Simulator Controls 

1.4.1.2.1 Circuit Simulator Options 

 
Add the global .option and .include commands. These commands can be used in the Time 
Domain characterization.  

For HSPICE simulation accurate characterization usually requires the .option delmax 
command. It sets the maximum allowable step size of the time steps taken during Transient 
analysis. 
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.option delmax=1p  

or  

.option delmax=2p. 

.option delmax  

For this exercise, you can set  

.option delmax=2p. 

 

NOTE! Do not run the simulation using HSPICE without specifying the 
delmax option. Setting this option increases the simulation time.   

1.4.1.2.2 Channel Simulator Controls 

 
This field enables expert users to pass specific controls to the Channel Simulator. These controls 
will be reflected in the simulation results. 
Following are some of the options which can be input in the Channel Simulator Controls field. 
Format: <command_name> <value(s)> 
• AMI Model Controls 

These options address deficiencies in AMI models.  

− useblkflt 
Format: useblkflt <number> 
Description: Controls the getwave size. The getwave blocks will be made of <number> 
bits. 

− ignoreamiclk 
Format: ignoreamiclk 
Description: Ignores the clock vector returned by the AMI model. 

 

NOTE! 
You should avoid using these controls.  
Use them only if the AMI model is not IBIS compliant and not robust. 

• Cheap Probing 
− probealleyes 

Format: probealleyes 
Description: Normally the eye contour is ISI only eye contour at the Rx output. You can 
also output ISI only eye contours at the following additional points: 
o Tx input 
o Tx output (if the Tx has an AMI model and the model uses getwave) 
o Rx input 
The files will be in standard tab delimited ASCII format and will be named as: 
o eyectr_in.txt (Rx input) 
o eyectr_tx.txt (Tx input and output only if Tx AMI model with getwave is available) 
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o eyectr_tx_in.txt 
• User Supplied Step Responses (from 13.0 only) 

The channel characterization can be overwritten with a user supplied step response file. 
The syntax is more complex.  

− Format: 
impfile (<tx_id> 
<path_to_user_supplied_rx_step_response_file> (type step)) 

Description:  
<tx_id> is the name of the Tx block. It should be the same name as that appears in the 
command.txt file. 
<user_supplied_rx_step_response_file> is a two-column step response 
file. The first column is time, and the second column is the step response. 

• Waveforms 
By default, 1000 bits of waveforms are output to waveform.txt. This output is controlled by 
the directive wavecnt. 
You can modify the number of bits by passing these as a parameter. The command syntax in 
that case is  wavecnt <#_bits> instead of just wavecnt. 

In addition to the Rx output, you can also continue on the theme of cheap probing by 
modifying wavecnt to output waveforms at Rx input, Tx input and Tx output by specifying 
these as parameters. The command is: 

wavecnt (tx)(txin) (rxin). 

The corresponding waveforms are available in the ASCII tab delimited files chan2_tx.txt, 
chan2_tx_in.txt, and chan2_in.txt, respectively. 

 

NOTE! Tx input and output waveforms will be available only if Tx has a getwave type 
of AMI model. 

• Tx Bits 
To save Tx bits as output, use the command output_txbits. 
The Tx bits are stored in a two-column (time and voltage) ASCII file, 
srcbit_<tx_id>.txt. 

• Changing ISI Only Eye Contour 
By default, the eye contour is ISI only eye (as opposed to BER eye). 
You can modify the eye contour to a BER eye by using the following directive: 

− Format: eyectr_nber 1e-12 
Description: The eye contour will now be 1e-12 nBER eye. 

− Format: eyectr_ber 1e-12 
Description: The eye contour will now be 1e-12 BER eye. 

− Format: eyectr_jnber 1e-12 
Description: The eye contour will now be 1e-12 BER eye. 

1.4.1.3 Windows 32 Bit AMI DLL Support in a Windows 64 Bit SystemSI Installation 
This feature is for 64 bit Windows SystemSI – Serial Link Analysis installations.  
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When running channel simulations, it is necessary that the channel simulator (spdut.exe) is 
compiled for the same Operating System (OS) as the algorithmic models (AMI DLLs) that are 
being used. As it is fairly common for SerDes suppliers to distribute win32 AMI DLLs, and fairly 
common for you to install win64 software on their computers, this feature has been added to 
enable compatibility in these scenarios. 
You can find a folder win32 under the 
<INSTALL_DIR>\SpeedXP\Library\template\SystemSI\SerialLink\amiwin 
folder.  

• The amiwin folder contains the 64 bit AMI parameter files and DLL files 
• The win32 folder contains the 32 bit Windows AMI DLLs and channel simulator 

 
A new option, Channel Simulator OS, is added to the Analysis Options window for Windows 
64 bit SystemSI – Serial Link Analysis. 

 
It has two options: 

• Windows 64 Bit 
• Windows 32 Bit 
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The default is Windows 64 Bit. If the AMI models you are using are 32 bit DLLs, you should 
select Windows 32 Bit.  

If your DLLs do not match the selected Channel Simulator OS, the channel simulation aborts, and 
following message is displayed. 

 
Click Yes to view the spdut.log file. It provides information about the nature of the error.  
 

NOTE! 
SystemSI installation has both, win64 and win32, versions of the AMI models. 
Based on the value specified in the Channel Simulator OS field,  appropriate 
version of the DLLs and channel simulator are used. 

1.4.1.4 Simulation Name 
Define Simulation Result Name.  

 
 By default,  the Automatic option is selected. In this case, the result folder names are 

automatically defined according to the simulation times. 
 If you select the Custom option, you need to specify the simulation name before the start of 

the simulation.  

When you click the Play button , the Simulation Name window pops up. Enter the 
name of result folder.  

 

1.4.2 Analysis Setup 

1.4.2.1 General Channel Simulation Parameters 

 
 Ignore Time (ns)  

Specifies the initial time to be ignored from the waveform, so that the data is not corrupted 
with the startup time transients.   
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Default value is 5000 ns. You can use a lower value such as 100 ns if you do not use adaptive 
equalizers like adaptive DFE.  

 Number of Bits  

Specifies how many bits to simulate. The default value is 200,000. 

For BER computation you need to simulate at least 100,000 bits. If you are doing crosstalk 
simulation, you may need to simulate more bits like 200,000.  

 Bit Sampling Rate  

Similar to time step in circuit simulation, which is used by the channel simulation engine. 
The larger the number is, the longer the simulation time is.  Default value is 32 samples/bit. 
The default is sufficient for most cases.  

 BER Floor  

Specifies the minimum Bit Error Rate or BER to be used in the simulation. The value can go 
up to 1e-20. Default value is 1e-20.  

1.4.2.2 Simulation Configuration 

 
 The Corner settings are for the IBIS block and the VRM block. It will be available for 

selection only when the design has an IBIS block or a VRM block.  

 The Ideal Power setup is for the VRM block. It will be checked and grayed out if the project 
does not have any VRM block.  

1.4.2.3 Xtalk 

 
Xtalk is not available in Single Channel Analysis. For the details of this part, please refer to 
Section 2.4.2 Xtalk in Crosstalk Channel Analysis. 

1.4.2.4 Eye Distribution Methods 

You can select an eye distribution method from this dialog. The default Eye Distribution is Time 
Domain Waveform (Channel Simulator). 
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Select Statistical to enable the eye distribution to be calculated statistically. 

 
If you select Statistical, in the next step BER_Eye generation is automatically selected by default.  

1.4.2.5 Statistical Eye Contours 

You can enable BER_Eye generation to generate statistical eye contours. If enabled, BER_Eyes 
are generated and displayed. Choose a criterion from: 

 Time scale (eye width)  

 Voltage scale (eye height) 

 Both time and voltage 

 
By default, Both time and voltage is checked when BER_Eye generation is enabled. 

After you select a criterion, the BER eye will be generated based on the criterion.  

If you place the cursor in the LBERs field, an indication box appears. The LBER values are 
displayed.  

 
 

NOTE! All LBERs should be negative integers. Set the LBER values within 
the –3 to –20 range.   
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1.4.2.6 IBIS Model Selection 

If any AMI model is included, it will be listed in the IBIS Model Selection part, as the example 
shown below. 

 

1.5 The First Simulation 
Any new channel needs to be characterized before running a channel simulation. Characterization 
of the channel means finding the step or impulse response. Run either HSPICE or SPDSIM 
simulation to characterize the channel. 
The standard_step.sp file is installed in the main programs directory under 

<INSTALL_DIR>\SpeedXP\Library\template\SystemSI\Serial Link Analysis 

This file is a standard stimulus sub-circuit used by the tool to generate the step response. All the 
characterization information for the channel is stored in the Workspace directory.   
 

NOTE! 
Do not edit the standard_step.sp file unless you are an 
advanced user and want to set up a different stimulus. 

1.5.1 Setting up Probe Point 
1. Click the connection point to open the Ckt Node menu. 

 
2. To set Probe Point for the simulation, click two Ckt Nodes in the menu. 
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 The two selected nodes are connected. 
 The node clicked first is defined as positive, and the second is negative. 

3. To view and edit the defined Probe Points, select 
Setup> Probe Point…. 

 
The Probe Point window opens below. 

 
4. To show or delete the defined Probe Points, right-click and select from the pop-up menu. 

 
5. After the simulation, the results of all the defined Probe Points can be viewed from the 2D 

Curve (Eye Contour) window, 3D Eye Density window and Report View window. 



 37 Product Version 16.6 

 

1.5.2 Begin Running the Simulation  
1. Click the Start Simulation button   to start a simulation. 
2. If the channel has been characterized before, the characterization is skipped and the channel 

simulator is invoked directly. 
3. On the Tools menu, click Channel Characterization to characterize the channel with only 

running the simulation. 

 
4. On the Setup menu, click Pause before Simulation. 
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5. If you have enabled Pause before Simulation from the Setup menu, a message will prompt 
you whenever a new simulation is about to be run. 

1.5.3 Simulation Directory 
Each simulation creates a unique directory (1, 2, 3 …etc) with all the waveform files under: 
\sc_example1\result.  
By default, these directories are moved to the history folder when opening an existing workspace 
file. However, you can make the following setup by choosing Tools > Options > Edit Options…, 
and clicking Result under Simulation.  
 

 
The first one is checked by default. 

The next illustration shows some of the waveforms generated by the channel engine. This 
illustration is the default display. To show the waveforms, select 
Tile 
or 
Cascade 
On the Windows menu, click To Default to arrange all open windows to the default display. 

Basically, the .ssix, .html and .txt windows should be put together at the top, and other curve 
windows should be put together at the bottom. 

The waveforms in the 2D Curve window are the most useful ones. The eye contour and bathtubs 
are very good measures of the quality of any channel.  

 Bathtub Curves - Provide the eye opening (in % UI) at a specific BER.  

 Noise Bathtub Curves - Provides the eye height (in Volt) at a specific BER.  
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Running the channel simulation at TX data rate of 3.125 Gbps produces waveforms with an eye 
opening of 0.64 UI at BER 1e-12 and an eye height of 360 mV at BER 1e-12. 
The following figure shows the bathtub curves from the previous simulation. 

 

 

1.5.4 Simulation Results 
The simulation results present the following waveforms:  

 3D  

－ Eye Density (Default)  

－ Bathtub  

 2D  



 40 Product Version 16.6 

－ Eye Contour (Default)  

－ Bathtub  

－ Noise Bathtub  

－ Ramp Response 

－ Impulse Response 

－ Modified Impulse Response 

 Channel report (Default)  

1.5.5 Run the Simulation Again 
If you click the Start Simulation button   to run the simulation again without making any 
changes to the channel components, the characterization of the channel is skipped. Only the 
channel simulation is run.  
Changes to the channel could mean:  

 Changing the parameters for Pkg1, PCB or Pkg2 blocks, by modifying the connections, or 
using a different sub-circuit model.  

 Changing Tx or Rx parameters, such as drive level or c_comp (for Tx). 

 Adding additional components to the channel.   

 Deleting any component from the channel.  

1.6 Increasing Data Rate  
This section describes how to run the simulation with an increased TX data rate, which would 
close the eye much more.  
1. Enable the AMI model (a standard FFE model) at the transmitter. Notice how the eye 

improves. 
2. Change the TX data rate to 10 Gbps  
3. Rerun the simulation. The results are as shown below: 



 41 Product Version 16.6 

 
4. Notice how the eye (green curve) is completely closed.  
5. Check the bathtub curves. 

 

1.7 Enable AMI  
1. Right-click on the AMI block. 
2. Click Enable to enable the AMI block at the transmitter. 
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3. Double-click on the AMI block to view its properties. Two files have already been loaded by 
default: 

 
The AMI model assigned to the TX_PRIMARY block is either: 

 AMIFFE  

 Feed Forward Equalizer 

The parameters are displayed in the AMI parameter window. 

 
4. Click the default fwd parameter to open the AMI Parameter Editor.  

 
5. Change the value in the AMI parameter window. The new value means the number of 

forward tabs has been increased to 4.  
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6. Rerun the simulation. 

1.7.1 Coeffout Parameter 
You can put a value for the coeffout parameter. 

Example  

coeffout = coeff.txt. 

The FFE coefficients are then output to the file coeff.txt. These are the optimized coefficients 
for this particular channel computed by the amiffe model.  Based on hardware implementation, the 
coefficients could be programmed into the real hardware for optimal performance. 

The Channel simulation results for data rate = 10 Gbps + TX FFE are shown in the next 
illustration. 

 
The closed eye is now open (blue curve). The next illustration shows the 2D Bathtub curves for 
the data rate = 10Gbps + TXFFE. Although the used FFE model does open the eye, the eye width 
at BER 1e-12 is only 0.27 UI compared to 0.64 UI for data rate of 3.125 Gbps. The eye height is 
only 60 mV compare to 360 mV. 
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1.7.2 Enabling AMI DFE @ RX_PRIMARY 
1. Right-click on the AMI block. 
2. Click Enable to enable the AMI block at the receiver.  

 
The default AMI model used at the receiver is amidfe2 or Decision Feedback Equalizer. 
3. Use the default parameters. 

 
The Channel simulation results for data rate = 10 Gbps + TX FFE + RX DFE are shown in the 
next illustrations. 

As you can see the eye (pink curve) does not open more. It actually closes more than a simulation 
using TX FFE alone. 
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The 2D Bathtub curves (pink curves).for the data rate = 10 Gbps + TX FFE + RX DFE are shown 
in the next illustration. 

This particular channel using the TX FFE model yields better results than with the RX DFE 
model.
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2 Crosstalk Channel Analysis 

This chapter describes how to perform a Crosstalk Channel Analysis. You will learn how to use an 
existing Crosstalk Channel template to demonstrate Crosstalk Channel Analysis. The chapter 
focuses on how to: 

 Assign Models to Components 

 Set up the Simulation Parameters 

 Set up the Simulation Options 

 Run Crosstalk Channel Simulations. 

What-if scenarios are used to see how the channel behaves to changes in the data rate as well as 
the inclusion of Crosstalk and Equalization via AMI models.  

2.1 Overview 
The Crosstalk Channel Template consists of three channels. Each channel contains:  

 One Transmitter 

 One Receiver 

 A Printed-Circuit Board(PCB) 

 Two Packages 

The next illustration shows two AMI blocks connected to the primary transmitter and primary 
receiver. You can add additional blocks and aggressors to modify the template.  

 

2.2 Starting the Crosstalk Channel Template 
Use the New Workspace dialog to create a new workspace. Do not change the contents of any of 
the template folders. These folders contain the component models, connectivity and settings used 
to create a new workspace directory.  
1. Launch SystemSI. 
2. In the File menu. Click New. 

 Alternatively, you can select the New button . 
The Select Module dialog opens. 
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3. Select Serial Link Analysis. 
4. Click OK. 

The New Workspace dialog for Crosstalk Channel appears. 

 
5. Click Create by template. 
6. Select xtalk_channel_sparam. 
7. Enter a name for the template. 
8. Enter a location for the template. 
9. Click OK. A directory for the new template is created in the location you entered. 

The following illustration shows the newly-created Crosstalk Channel Template workspace 
xtalk_example1.ssix. 
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2.2.1 Channel Blocks 
You can set up one or more block defaults for a new workspace. Do not attempt this if you are not 
an advanced user. You must pay careful attention to the connections between the blocks. 
The Crosstalk Channel Template contains the following blocks for each of the channels:  
 A transmitter 
 A receiver 
 Two packages 
 A printed-circuit board (PCB) 
 Two AMI models (only for the primary channel) 
 

NOTE! The AMI blocks are enabled by default. Disable them first for the 
following steps of setting. 

2.3 Examining Each Channel’s Component 
This section describes each block in the Crosstalk Channel workspace and the properties for each 
block. The focus is on the parameters and settings that are different from those in the Single 
Channel Template.  
All of the properties for each block are already set in the Crosstalk Channel Template. 
 

IMPORTANT! Do not change any block properties in the template. 

You can skip this section of the Tutorial, if you wish. This information in this section does not 
affect the simulation setup procedure.   

2.3.1 Transmitters 
Double-click on a transmitter block to view its properties.  
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The template has three transmitter blocks and each block has four tabs. 

 

2.3.1.1 Connection Tab 

This tab shows information about the connections between the transmitter’s block and other 
blocks. 

2.3.1.1.1 TX_PRIMARY 

 

2.3.1.1.2 TX_UPPER  

 

2.3.1.1.3 TX_LOWER 

 
The primary difference between the three connections is in the block connection name. The names 
are for the connections at Pkg1. 

2.3.1.2 Stimulus Tab 
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Please refer to Section 1.3.1.2 Stimulus Tab for details. 

2.3.1.3 Jitter & Noise Tab 

 
Please refer to Section 1.3.1.3 Jitter & Noise Tab for details. 

2.3.1.4 Power Supply Tab 

 
 Power Supply - Ideal voltage source that is used at the transmitter. Default value is 1 V. 

Please refer to Section 1.3.1.4 Power Supply Tab for details. 

2.3.2 Receivers 
Double-click on a receiver block to view its properties. 

 
The property pane contains three tabs. 

 

2.3.2.1 Connection Tab 

This tab shows the information about the connections between the receiver blocks and other 
blocks. 

2.3.2.1.1 RX_PRIMARY  
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2.3.2.1.2 RX_UPPER  

 

2.3.2.1.3 RX_LOWER 

 
The main difference between the three connections is in the block connections name.The names 
are for the connections at Pkg2. 

2.3.2.2 Jitter & Noise Tab 

 
Please refer to Section 1.3.2.2 Jitter & Noise Tab for details. 

2.3.2.3 Power Supply Tab 

 
 Power Supply - Ideal voltage source that is used at the receiver. Default value is 1 V. 

Please refer to Section 1.3.1.4 Power Supply Tab for details. 

2.3.3 Pkg1 
Double-click on the Pkg1 block to view its properties.  

 
The Property pane has two main sections:   
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 Connection 

 File and Content 

2.3.3.1 Connection 

 
The Connection window shows the connections between the Pkg1 block and the other blocks. 

2.3.3.2 File and content 

 
The Crosstalk Channel Template already provides a SPICE Netlist file, which includes another 
SPICE file with a sub-circuit model of a 12 port s-parameter file. You can edit this model. 

 

NOTE! Make sure to assign the nodes properly to maintain the connections 
with other blocks. 

2.3.4 Pkg2 
Refer to the Pkg1 section. The difference between Pkg1 and Pkg2 is in the connectivity and the 
model name. Both use the same package model. 

2.3.5 PCB 
Double-click the PCB block to view its properties.  
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The Property pane has two main sections:   

 Connection 

 File and Content 

2.3.5.1 Connection 

 
The connection window shows the connections between the blocks.   

2.3.5.2 File and content 

 

2.3.6 AMI 
The AMI model (@ RX_PRIMARY) in gray are disabled by default.   

When installing the Channel Analysis tool, a template directory is created with all the template 
files, as well as a new folder called amiwin. The folder contains all the AMI models.   
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2.4 Analysis Options 
This section covers the Analysis Options in the Setup menu.  

On the Setup menu, click Analysis Options…. 

 
The Analysis Options interface opens. 

 

2.4.1 Circuit Simulator Options 
Add the global .option and .include commands. These can be used in the Time Domain 
characterization. 

 
HSPICE simulations usually require one of these options for accurate characterization. 

    delmax=1p or  delmax=2p.   

The Delmax option sets the maximum allowable step size of the time steps taken during transient 
analysis in HSPICE. 

 

NOTE! 
This option increases the simulation time but provides more accurate result, 
especially when using HSPICE. The option in this exercise is commented out. 
SPDSIM is used as the circuit simulator since it does not require 1 ps time step. 
It is faster than HSPICE without sacrificing accuracy.  

2.4.2 Xtalk 
Several types of Crosstalk can be selected:  
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Odd - Crosstalk Channels switch opposite to the primary channel as 180º out-of-phase. The Odd 
Crosstalk mode is selected by default. 

Even - Crosstalk Channels switch in-phase with the primary channel.  

Random - Crosstalk Channels switch randomly with respect to the primary channel.  

Statistical - Primary channel is simulated. The eye density is obtained. Based on the pulse 
response of the Crosstalk Channels, all of the Interferences of the Crosstalk Channels are 
statistically added. This should exhaustively add all possible interferences. 

2.4.3 Terminate Unconnected Nodes 
If there are some unused nodes in the block, SystemSI will automatically terminate the unused 
nodes.  
By default, the termination value for Signal node is 50Ohm, for Power node is 1e+008Ohm and 
for Ground node is 0Ohm.  
To change the termination value, follow these steps: 
1. Select 

Setup > Terminate Unconnected Nodes…. 

 
2. The Termination Impedance Definition window pops up. 

 
 

NOTE! 
SystemSI will add termination for unused nodes in the blocks except 
Transmitters and Receivers blocks. 

2.5 Running Simulation 
This section describes how to run several simulations: 

 AC Sweep 

 First Simulation (Default settings) 

 Enabling AMI DFE @ RX PRIMARY 
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 Turning on Statistical crosstalk 

2.5.1 AC Sweep 
Before running any transient or channel simulation, run AC sweep. This detects the coupling 
percentage between the primary channel and all other channels.  
1. On the Tools menu, click Detect Crosstalk….  

 
2. Select all transmitters. 
3. Click Calculate. 

 
All coupling is calculated for all channels with respect to the Victim Rx.  

The Primary channel is identified as the one with the most power transferred from TX to 
RX.   
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The default maximum frequency is 1 GHz. You can change the value to a higher frequency. 
Notice the impact on the coupling factor. 

The next two figures represent the AC sweep results. The AC sweep results show the voltage at 
receivers. 
Primary 

 

 
Upper and Lower 
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2.5.2 First Simulation (Default Settings) 
Click the Start Simulation button  to start a simulation. The purpose of the Start Simulation 
button is to characterize the channel. If the channel has not been characterized before, the button 
invokes the channel engine.  

Any new channel needs to be characterized first before running channel simulation. 
Characterization of the channel means finding the step or impulse response. Run either an 
HSPICE or SPDSIM simulation to characterize the channel. 

The standard_step.sp is installed in the main programs directory. This file is a standard 
stimulus sub-circuit used by the tool to generate the step response. 

<INSTALL_DIR>\SpeedXP\Library\template\SystemSI\Serial Link Analysis 

 

IMPORTANT! 
Do not edit the standard_step.sp file unless you are an advanced 
user and want to set up a different stimulus. 

All the characterization information for the channel is stored in the Workspace directory.   

2.5.2.1 Change Parameters 

If you click  to run the simulation again without making any changes to the channel components, 
the characterization of the channel is skipped. Only the channel simulation is run. Changes to the 
channel include:  

 Changing the parameters for Pkg1, PCB or Pkg2 blocks, by modifying the connections, or 
using a different sub-circuit model.  

 Changing Tx or Rx parameters, such as drive level or c_comp (for Tx). 

 Adding additional components to the channel.   

 Deleting any component from the channel.  
1. Select the Tools menu. 
2. To characterize the channel only without running the channel simulation, click  

Channel Characterization. 
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2.5.2.2 Pause before Simulation 

The Pause before Simulation option prompts you with a message whenever a new simulation is 
about to be run.   
1. Select the Setup menu. 
2. Click Pause before Simulation.  

 

2.5.2.3 General Options 
Select Tools > Options > Edit options…. 

 
The Options window opens. 
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The General sheet contains three sections: 
 Automation - you can put email address into the blank dialog box, and then you can get 

notification email when simulation is complete  
 Multiple CPU usage - you can set the maximum number of CPU to use in the simulation 
 Messages and Windows  -- Select the options to display or hide the simulation messages . 

2.5.3 Simulation Results 
The simulation results consist of the following waveforms:  

 3D  

－ Eye Density (Default)  

－ Bathtub  

 2D  

－ Eye Contour (Default)  

－ Bathtub  

－ Noise Bathtub  

－ Ramp Response 

－ Impulse Response 

－ Modified Impulse Response 

－ Rx Waveform 

 Channel report (Default)  
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Each simulation creates a unique directory (1, 2, 3 …etc.). All the waveform files under 
\xtalk_example1\result.  

These directories are moved to the history folder when SystemSI is closed.  

The following figure shows the Channel simulation results for Data rate = 5 Gbps. Running the 
channel simulation at a Data rate of 5 Gbps produces an eye contour that is not open very well. 

 

2.5.4 Enable AMI DFE  
Enable the AMI model at the receiver. That AMI model is a standard DFE or Decision Feedback 
Equalizer model. 
1. Run the simulation again.  
2. Right-click on the AMI block. 
3. Select Enable to enable the AMI block at the primary receiver. 

 
The Property pane for the AMI block is already loaded with an AMIDFE model: 

 
4. Use the default parameters shown in the example below: 
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5. Rerun the simulation. 
6. Observe the results.  

The following illustration shows the Channel simulation results for a Data rate = 5 Gbps + 
RX DFE. 

7. Notice the eye contour opens up nicely. 

 

2.5.5 Turn on Statistical Crosstalk 
The section describes how to turn on Statistical crosstalk.  
1. Choose Setup > Analysis Options…. 
2. Select Statistical.  

 
The results show a Channel simulation results for Data rate = 5 Gbps + TXFFE + Statistical xtalk 
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3 Sigrity AMI Models 

The Sigrity SystemSI – Serial Link Analysis includes several SERDES equalizer behavior models. 
All of these models use the Algorithmic Model Interface (AMI). This chapter describes using the 
Sigrity AMI models. 

3.1 Model Design 
AMI Models can be added to Tx or Rx. 

 
AMI Models can also be cascaded. This allows flexible modeling and debugging. The example 
shows a Cascaded Equalizer Model with a stand-along CDR (Clock & Data Recovery). 
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3.2 Model Configuration 
 AMICDR — Recovers the Reference Clock signal and aligns it to the middle of the eye. 
 Typically at Rx. 
 AMICTWF — Used for Continuous Time Linear Equalization. 
 AMICTWFADAPT — Adaptive version of AMICTWF. 
 AMIFFE — Feed Forward Equalization. Pre-de-emphasis; typically at Tx. 
 AMIDFE2 — Decision Feedback Equalization. 
 AMIDFENL — Advanced. Non-linear DFE. 

3.2.1 AMICDR Configuration 
The algorithmic model is amicdr2.dll. 

3.2.1.1 AMICDR Description 
AMICDR is generally applied at the Rx side. CDR: 
1. Takes in raw data waveforms.  
2. Recovers the reference clock signal. 
3. Aligns it to the middle of the eye. 

3.2.1.2 AMICDR User Parameters 

 

3.2.2 AMICTWF Configuration 
The algorithmic model is amictwf.dll. 
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3.2.2.1 AMICTWF Description 
CTWF stands for Continuous Time Waveform.  
It is used for Continuous Time Linear Equalization. 
It typically applies high-pass frequency filtering to the incoming signal at the Rx side. 

3.2.2.2 AMICTWF User Parameters 

 

3.2.3 AMICTWFADAPT Configuration 
The algorithmic model is amictwfadapt.dll. 

3.2.3.1 AMICTWFADAPT Description 
AMICTWFADAPT is the adaptive version of AMICTWF.  
It includes an adaptive high-pass filtering algorithm.  
It has optional integrated CDR and DFE functionality. 

3.2.3.2 AMICTWFADAPT User Parameters 

 

3.2.4 AMIFFE Configuration 
Feed Forward Equalization is represented mathematically as:  

yn = Σ wi*xi 

xn - input 

Yn - output 
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3.2.4.1 AMIFFE Description 
AMIFFE is generally applied at the Tx side. It can be applied to the Rx. They are mathematically 
equivalent. The filter is specified by:  
 Number of Taps   
 Tap Coefficients — Set of weighing factors (wi). 
 Tap Spacing — Delay between taps. AMIFFE assumes Tap Spacing is one bit at a time. 

3.2.4.2 AMIFFE Tap Terminology 

 

3.2.4.3 AMIFFE Automatically Optimizes the Tap Coefficients 
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3.2.4.4 AMIFFE.AMI User Parameters 

 
The AMI parameter “lffe” is an important parameter for the “amiffe.dll” algorithmic model. This 
parameter sets both the number of taps (it will override the “fwd” parameter if it exists), and also 
the limits on those taps. 
The AMI parameter “csum” can be set to make the sum of all taps=1. Otherwise the main tap will 
be “1” and the other taps will take values no greater than their associated 'lffe' limit. 
If you do not want a precursor tap, set the “lffe” parameter in the following manner: 
( <val_less_than_1> ,,,,,,,) 

3.2.5 AMIDFE2 Configuration 
DFE stands for Decision Feedback Equalizer. It removes the Inter-symbol Interface (ISI) by 
adding corrections to the input based on previous decisions. Decision Feedback Equalization is 
represented mathematically as:  

yn = Xn + Σ wi*di  

yn - output 
xn - input 
di - previous ith decision 

wi - ith tap weight 
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3.2.5.1 AMIDFE2 Description 
The Tap weights are determined adaptively by the equalizer and cannot be set by the user. This is 
also known as blind equalization. During the simulation an ignore_time setting of 5000ns is 
recommend-ed. This ensures that the adaption algorithm has enough time to settle.  
DFE has an integrated Clock and Data Recovery module (CDR). This DFE does not correct pre-
cursor ISI. The best results are obtained when an FFE with precursor correction is applied at the 
Tx side. DFE is applied to the Rx device. 

3.2.5.2 AMIDFE2 LMS Algorithm 
The Least Mean Square (LMS) adaptive algorithm looks like this:  

wi(n + 1) = Wi(n) + υ * E * dm(n) 

Wi − ith coefficient 
di − ith symbol 

E − error 
υ − proportionality factor 

3.2.5.3 DFE Coefficient Dynamic Adaptation Example 
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3.2.5.4 AMIDFE2 User Parameters 

 

3.2.6 AMIDFENL Configuration 

 

3.2.6.1 AMIDFENL Description 
The DFE coefficients by blind adaptation are:  
 Standard linear feedback error minimization algorithm. 
 Optional non-linear erro minimization algorithm.  
 Optional tuning of decision point. 
Optionally include precursor.Optional adaptive gain amplifier means the algorithm decides on 
amplification based upon the corrected waveform.  
AMIDFENL includes: 
 Optional tuning of decision point. 
 Optionally include precursor. 
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3.2.6.2 AMIDFENL User Parameters 
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4 Advanced Capabilities 

This chapter covers following advanced capabilities in SystemSI – Serial Link Analysis (SSI–
SLA).  

 IBIS Transmitter and Receiver 

 Sweep Manager 

 S-Parameter Extraction 

 Jitter Tolerance 

 Block Sensitivity  

 Result Browser and 2D Curve Presentation 

 Auto Archive SSI Project 

 Integration with Allegro Signal Explorer 
Use these capabilities to further investigate channel performance and optimize the design. 

4.1 IBIS Transmitter and Receiver 

4.1.1 Add IBIS Transmitter and Receiver 

1. Click the Add IBIS Transmitter icon  or Add IBIS Receiver icon . 
2. Click in the layout view window. 

The Tx1 or Rx1 block is added. 

 
 

 

4.1.2 Load an IBIS File 
1. Double-click the IBIS Tx or IBIS Rx block. The Property pane opens. 
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2. Click the Load IBIS… button. The Load IBIS window opens. 

 

3. Click the  button to load an IBIS file.  
4. Choose from the Component drop-down list to select a component for the IBIS Tx block or 

IBIS Rx block. 

 
The Pin Mapping tab is shown. 
The references, including Pullup, Pulldown and Gnd/Pwr rails for the Bus Signals, are 
identified in the Pin Mapping.  
In the example below, Serial Link Analysis will assume Ideal Power and Ground for all 
simulations. 
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5. Click the Diff Pin tab, and select a diff pin pair. 

 
If the IO models have any AMI models, please select an OS that matches the OS of the 
Channel Simulator. 
If the IO model is selected for the simulation, the selected AMI model will be used. The .sp 
file for the selected IBIS component will be automatically created and assigned to the IBIS 
block.  
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4.2 Sweep Manager  
The exercise uses one of the single channel templates. The types of sweeps are explained and in 
different case examples. 
The Sweep Manager supports six types of sweeps.  

 
 Analysis Options – Sweeps parameters defined in Analysis Options. 

 AMI Parameters - Sweeps AMI model parameters such as the number of forward tabs and 
coefficients.  

 VMI Parameters - Vendor Model Interface. Companion capability that can be used 
together with standard IBIS-AMI models to enable additional automation from advanced 
SERDES IP suppliers.  

 Transmitter Parameters - Sweeps transmitter parameters like data rate and number of bits.  

 Receiver Parameters – Sweeps receiver parameters like random jitter and deterministic 
jitter. 

If IBIS transmitter and receiver are added, the Transmit IO Model and Receive IO Model are 
be added to the Sweep Manager for sweeping. 
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 Models - Sweeps SPICE Netlist files such as .Inc models or other parameters.   

4.2.1 Launch Single Channel Complex Template  
1. Launch SystemSI. 
2. In the File menu, click New; 

or 
in the Main toolbar, click the New button. 
The Select Module dialog opens. 

 
3. Select Serial Link Analysis. 
4. Click OK. 

The New Workspace dialog (Single Channel Template) opens. 

 
5. Select Create by template. 
6. Enter a name for the new workspace, such as simple_complex. 
7. Enter or select a location. 
8. Click OK. The workplace appears.  
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The single channel complex template contains the following blocks: 

 A primary transmitter (Tx1) 

 A primary receiver (Rx1) 

 Two packages (txpkg and rxpkg)  

 Two add-in cards (card1 and card2) 

 Two connectors (conn1 and conn2) 

 A backplane (BackPlane) 

 Two AMI models 

 

NOTE! 
You can either double-click on a component in the canvas or select a 
component and click the Property button  on the Select toolbar to 
view the properties. 

4.2.1.1 Block Models 

Each block contains the following models.  

Component Circuit model 

Tx nmos output driver behavior model.       

Rx simple input behavior model. 

txpkg, rxpkg S-parameter package model (s4p). 

card1, card2 Approximate 3-inch daughter card; w-element model. 

conn1, conn2 VHDM distributed circuit connector model. 

BackPlane  24-inch XAUI type channel (s4p). 

4.2.2 Explore Sweep Manager  
• Start in the Tools menu. 
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• Click Sweep Manager…. 

The Sweep Manager interface opens. The Sweep Manager interface has three sections: 

 Parameter 

 Sweep List 

 Iteration 

 

4.2.2.1 Sweep Mode 

The two options supported are: 

• Channel Simulation 

• Frequency Response 

4.2.2.2 Sweep Type 
By default, Analysis Options is selected as the sweep type.  

Based on the Sweep Type selected, different values are populated in the first list box. You can 
either click or double-click on a parameter to add to the Sweep List. 
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In the example shown, the sweep name appears in the Sweep List if you click on fwd. 

 

4.2.2.3 Sweep List 

To choose parameter values, select the Sweep item from the Sweep List and go to the next section. 
The Sweep List pane contains these items: 

 Sweep Element- Identify the Sweep Type and parameter or model selected. 

 Sweep Type - Choose from the drop-down menu.  

 Step Count - Number of different values for each parameter. 

 Min, Max, Step, and Value List - Related element values.  

 
Sweep Type 

The default Sweep Type is dependent on the parameter chosen. In this example, Parameter is the 
default. 

 

4.2.2.4 Total Iterations 
Total Iterations are the total number of simulations to be preformed. 
In this example, 3 Iterations will be performed.  
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1. Right-click the spreadsheet of Total Iterations.  

Two options Export Settings... and Import Settings... are available in the pop-up menu list. 

 
They are used to export and import the Iteration settings in the csv file. 

2. Click Export Settings.... 
The Export settings window opens.  
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3. Click Save to save a csv file listing all the possible iterations. 
4. Open the saved csv file. 

 
• The number 1 in the Iteration column indicates this iteration is enabled in the Total 

Iterations spreadsheet 
• The number 0 in the Iteration column indicates this iteration is disabled in the Total 

Iterations spreadsheet 
5. Change the Iteration value of the first row to 0 as follows, and save the file. 

 
6. Click Import Settings... in the Sweep Manager window. 



 81 Product Version 16.6 

 
The Import settings window opens. 

 
7. Choose the saved csv file, and click Open. 

The settings of iterations in the csv file are shown in the Total Iterations spreadsheet. 

 
The first row of Iteration is disabled. 
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NOTE! 
The .csv file to be imported must match the content of the Total 
Iterations spreadsheet; otherwise an error message will display to show its 
failure. 

4.2.2.5 Results 
1. After all simulations are done, click the Results tab to display the results.  

 
2. To view curves such as Eye contour and Bathtub curves, highlight one or more iterations and 

click . 

4.2.3 Running a Single Sweep 
Set up the Simulation Sweep Options and run the sweep using the example in Section 4.3.1 
Launch Single Channel Complex Template. 

4.2.3.1 Analysis Options 

When the Sweep Manager is open, the Sweep Mode option is automatically selected.  

 
Make sure the Sweep Manager interface is open. Click OK to start simulation. 

 

4.2.3.2 View the Results 
Click the Results tab after the simulations finish. The Results pane displays: 

 Measured Eye Height (mV) 
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 Eye Jitter (UI) 

 File Location(Folder path) 

 Eye NJN 

 List of all the Iterations 

 Tx1 

 
Two settings for the fwd parameter do not produce any eye opening. 
1. Select one or more iterations. 
2. Click  to view the curves. The Show Simulation Result dialog appears. 

 
3. Click OK. The Eye Contour results appear. 
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The Bathtub cureves for all the iterations appear. 

 
4. Click the Export button  in the Sweep Manager interface to export the results.  
The Save As dialog opens. 
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4.2.4 Run Multiple Sweeps 
This section describes how to sweep multiple parameters and across categories to show the sweep 
capability.The parameters and the values are to be set:  

fwd of amiffe: 2, 3  

Data Rate of Tx1 (Gbps): 5, 8  

DCD of Tx1 (%): 0, 1 

There are a total of 8 combinations.  

 
After the simulations are run, the results appear in the Results pane. The results from the first 
sweep are now found under the History tab. 
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4.2.5 Other Sweep Features 
The Sweep Manager can group parameters and help select Sweep Models. 

4.2.5.1 Grouping Parameters 

You can group two or more parameters to reduce the number of iterations. 

For example, the Data Rate and DCD parameters can be grouped together as shown in the 
following examples. 
1. Select the two rows (for Data Rate and DCD). 
2. Right-click,Click on Group.  

 
The number of Total Iterations drops from 8 to 4. 

 
Originally, the iterations look like this: 
Iteration fwd Data Rate (Gbps) DCD (%) 

1 2 5 0 
2 3 5 0 
3 2 8 0 
4 3 8 0 
5 2 5 1 
6 3 5 1 
7 2 8 1 
8 3 8 1 

After grouping the Data Rate and DCD, the new iterations are: 

Iteration fwd Data Rate (Gbps) DCD (%) 
1 2 5 0 
2 3 5 0 
3 2 8 1 
4 3 8 1 

When combining two or more parameters in a group: 

The first value for each parameter in the group constitutes one combination. 

The second value for each parameter constitutes the second iteration. 

…… 
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NOTE! 
Within a group, the value in the Step Count column of each parameter must be 
identical. Or else, the Total Iterations of the group will be 0. 

4.2.5.2 Model Sweep 

The Sweep Manager allows you to perform different types of Model Sweep: 

 .Inc sweep - Sweep multiple circuit models if the original model is called within a 
.include statement (such as conn1 and conn2 blocks).  

 Model File sweepSweep different parameters defined in the .sp files (such as c_comp for 
the Tx1 block). 

or spice sub-circuit files for one or more blocks, and sweep them. 
Model File  

When using the Model File sweep, make sure that the connectivity inside each .sp file is the 
same to maintain everything between  and .  

Click the New button  to add model files.  

 
.Inc Sweep 

When using .Inc sweep make sure that the sub-circuit name inside .cir file or other circuit files 
all have the same name. 

Click the New button  to add circuit files.  

 
Parameter Sweep 
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4.3 S-Parameter Extraction  

4.3.1 Launch Single Channel Complex Template 
This exercise uses the same workspace as section Sweep Manager. 

Click Open in the File menu to open the single_channel_complex Template.  

 
The single_channel_complex template workplace is shown below. 

 
The Single Channel Complex template contains the following blocks: 



 89 Product Version 16.6 

 A Primary Transmitter (Tx1) 

 A Primary Receiver (Rx1) 

 Two Packages (txpkg and rxpkg)  

 Two Add-in Cards (card1 and card2) 

 Two Connectors (conn1 and conn2) 

 A Backplane (BackPlane) 

 Two AMI Models 

4.3.2 S-Parameter Extraction 
SystemSI - Serial Link Analysis supports S-Parameter Extraction for both single-ended nets and 
differential nets. 
Select 

Tools > S Parameter Extraction…. 

 
The S Parameter Extraction window opens. 

 

4.3.2.1 Single-ended Mode 
1. Click the Single-ended Mode tab. 



 90 Product Version 16.6 

 
2. Select the BackPlane component to extract S Parameter. 

 
3. Set up ports. 

3.1 Click posin to define positive node. 

 
3.2 Choose ngnd as Ground node. 

 

3.3 Click the  button. 
Settings for Port_1 are completed as the following window shows. 
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3.4 Repeat Step 3.1 to 3.3 to define the circuit node posout. 

Settings for Port_2 are completed as the following window shows. 

 
4. Set up Parameters. 

4.1 Define Frequency Range. 

  
4.2 Define No. of Frequency Points. 

 
4.3 Input Parameter File Name. For example: S_para. 

 
4.4 Select Parameter File Format: bnp. 

 
5. Click the Extract button. 

S Parameter curves for Port_1 and Port_2 show as the following figure. 
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S Parameter document is automatically generated in the folder of <working folder 
path>\result\sparam\. 

4.3.2.2 Differential Mode  
1. Click the Differential Mode tab. 

 
2. Select the txpkg component to extract S Parameter. 

 
3. Set up ports. 

3.1 Choose ngnd as Ground node. 
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3.2 Click the circuit node posin to define positive node. 
3.3 Right-click the circuit node negin to define negative node. 

 

3.4 Click the  button. 
The port Diff_Port_1 is generated automatically.  

3.5 Repeat Step 3.1 to 3.3 to define the rxpkg component (define posout as positive node 
and negout as negative node). 

The port Diff_Port_2 will be generated automatically. 

 
4. Set up parameters. 

4.1 Define Frequency Range. 
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4.2 Define No. of Frequency Points. 

 
4.3 Input Parameter File Name. For example: S_para. 

 
4.4 Select Parameter File Format: bnp. 

 
5. Click the Extract button. 

S Parameter curves show as the following figure. 

 

4.3.3 S-Parameter View 
1. Select 

Tools > S Parameter Viewer. 

 
The Port Curves window opens. 
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2. Right-click the Network Parameters pane. 
3. Select Load in the pop-up menu list. 

 
The Open window opens. 
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4. Select an S Parameter, e.g. S_para_S.bnp. 
5. Click Open. 

The curve shows in the result pane like the following figure. 

 

4.4 S-Parameter Wrapping and BBS Integration 

4.4.1 Add S Parameter Block 
1. Click the Add S Parameter Block icon  on the tool bar, and click in the Layout window.  

The S Parameter block S1 is added. 
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2. Double-click the S1 block.  

The Property pane opens. 

 

4.4.2 Load S Parameter File 
1. Click the Load S Parameters… button. 

The Load S Parameters window opens. 
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2. Load the S Parameter file (BNP or Touchstone) to the S Parameter block.  

The kr_test_channel.BNP file is used as an example in this part. 
Once the selected S Parameter file is successfully loaded, an .sp file will be automatically 
generated and loaded to the block. 
• The .sp file will be displayed in the File Name field 
• The S Parameter file will be displayed in the S Parameter File field 

 
• For the BNP file, if the BNP file has the MCP information, the MCP section will be 

automatically added to the .sp file for connection 
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• For the Touchstone file, or the BNP file which does not have the MCP information, you 
are expected to manually add the MCP through the MCP Editor 
 

NOTE! Editing of .sp file for the S Parameters is NOT recommended.  

4.4.3 Extract the BBS Model 
1. Click the Extract BBS Model… button. 

The BroadbandSPICE application is launched. 

 
2. Click the FD Checking, Tuning, Extraction and TD Checking workflow to check and tune 

the S Parameters. 
For the application of BroadbandSPICE, please refer to BroadbandSPICE_Tutorial.pdf and 
BroadbandSPICE_UG.pdf. 

3. If the S Parameter checking result looks good to you, click Setup extraction in the workflow. 
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The Options window opens.  
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4. Set up the extraction settings as desired. 
5. Click Start extraction in the workflow to extract the BBS model.  

If the BBS model extraction is successful, a .txt file will be automatically generated.  
6. Click the Load BBS Model… button to load the generated BBS model 

kr_test_channel_BBSckt.txt.  

 
Once the BBS model is successfully loaded, an .sp file will be automatically generated and 
loaded to the block.  
• The .sp file will be displayed in the File Name field 
• The BBS model .txt file will be displayed in the BBS Model File field 
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NOTE! Editing of .sp file for the BBS model is NOT recommended. 

4.4.4 Load the BBS Model 
If you have the BBS models for the selected S Parameters, click the Load BBS Model… button to 
directly load the BBS .txt file.  
Please refer to Step 6 in Section 4.4.3 Extract the BBS Model for details. 
If the loaded BBS model does not match the original S Parameters, an error message will be 
issued. 

 

4.4.5 Switch the Models 
1. Click the Go To S Parameters button to switch to the original S Parameters model. 

 
2. Click the Go To BBS button to switch back to the BBS model: 
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NOTE! 
The MCP section will be shared among the BBS models and the original S 
Parameter model. Any MCP change to one .sp file through the MCP Editor will 
automatically update the MCP section in other .sp files. 

4.5 Block Sensitivity 
Understanding the contribution of different system components to Jitter and Noise, and 
subsequently tuning these components, are key to a successful design. 

The eye opening is one of the well understood and useful metrics used to assess system 
performance. The conventional scheme for the eye opening is inconsistent; only the time scale is 
normalized. 

NOTE! 

Block Sensitivity analysis requires SystemSI to automatically short out blocks. 
This is dependent on the MCP signal names in the models associated with the 
blocks. For a given block, for each terminal in the model, SystemSI needs to be 
able to find an associated terminal with the same MCP signal name, in order to 
correctly place a shorting element between the 2 terminals. This requires that 
"thru" signals in the model have the same MCP signal name associated with its 
terminals. 

 

4.5.1 Normalized Jitter and Noise 
The Block Sensitivity feature uses a novel eye-area-based normalized Jitter and Noise (NJN) 
metric. The goal is to find out the effect of each system component on Jitter and Noise.  

The NJN is obtained by using the entire area of the eye (Total area) as the normalizing parameter. 
Normalized Jitter and Noise is defined as:   

NJN = 1- (Eye area/Total area) 
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This diagram shows the Total Area and Eye Area.  

The Total Area includes the Eye area. The Eye area in this NJN metric reflects deterministic 
Jitter contribution. 

 
A subtractive methodology is used to examine each component’s contribution. 

a. The entire topology is simulated to establish a baseline. 
     b. A number of sweeps are automatically run. 
     c. Each block is sorted in turn to quantify its effect on the overall result.  
     d. The relative contribution of each block is tabulated in terms of normalized Jitter and Noise 
(NJN). 

e. The contributions of each block are displayed in bar graph.  

A non-zero eye opening is required to run the Block Sensitivity feature at any data rate and get 
meaningful results. 

At a high Data Rate using equalization (such as amiffe) may be necessary to meet the 
requirement. 

4.5.2 Launch Single Channel Complex Template  
This exercise uses the same workspace as section Sweep Manager. 

Click Open in the File menu to open the single_channel_complex Template.  

 
The single_channel_complex Template workplace is shown below. 
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The Single Channel Complex Template contains the following blocks: 

 A Primary Transmitter (Tx1) 

 A Primary Receiver (Rx1) 

 Two Packages (txpkg and rxpkg)  

 Two Add-in Cards (card1 and card2) 

 Two Connectors (conn1 and conn2) 

 A Backplane (BackPlane) 

 Two AMI Models 

4.5.3 Set up Simulation Parameters 
This exercise uses most of the default parameters of the template. The Tx1 data rate is 10 Gbps. 
Equalization is needed to get an open eye. 

We are using the results of the single sweep in the Sweep Manager section. 

Set the number of forward tabs for the amiffee AMI model to 3 when you are running a single 
sweep. 
This setting is necessary to get any eye opening. 

1. Double-click the AMI block connected to the Tx1 block to view its parameters. 

 
2. Change the default fwd parameter to 4. 
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3. In the Setup menu, click Analysis Options…. 

 
Circuit Simulator 

 
Circuit Simulator Options 

 
Make sure that the chosen circuit simulator is SPDSIM without .option delmax set. 

4.5.4 Start Block Sensitivity 
In the Tools menu, click 
 Block Sensitivity. 

Once you start Block Sensitivity, the tool immediately prompts you to confirm the number of 
simulations to be run.  

The channel has seven blocks. The number of simulations will be 7 + 1 = 8. The first simulation is 
used as the reference. 

 
A net name must be associated with each node in the channel. If not, the Block Sensitivity will not 
work. You can assign Net names from the Block Property panes or from the MCP Editor.   
In the following image the second column shows which block is being sorted. 
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4.5.5 View and Analyze the Results 
After the simulations are done, the results appear as shown in the following illustrations. 

 

4.5.5.1 Block Sensitivity Result Pane 
The Block Sensitivity Result pane has four columns: 

 Iteration - Lists the number of iterations in an ascending order.  

 Block Shorted - Lists which block is being shorted, with the first one used as the reference 
(no block shorted). 

 NJN - Normalized Jitter and Noise Results. Obtained from the formula: 
 NJN = 1- (Eye area/Total area). 

 NJN Contribution - Ratio of the NJN of the shorted block to the NJN when no blocks are 
shorted. Obtained from the formula:  

NJN Contribution = [1– (NJN (shorted block) / NJN (no block shorted))]*100 

 



 108 Product Version 16.6 

4.5.5.2 Block Sensitivity Analysis 
 
The Block Sensitivity Analysis chart displays NJN Contribution results. 

 
Click on the column header NJN Contribution (%) to sort the results in ascending or descending 
order. 

The largest contribution to Jitter and Noise comes from the BackPlane. 

Multiple contributions are negative, which indicates that the eye gets worse when the component 
is shorted. It is difficult to predict what will happen when components are shorted.  
The NJN Contribution of txpkg and rxpkg blocks is 0% because these blocks already have 
dummy models in the default template. 

4.5.5.2.1 To Show Results 
1. Right-click in the list to display all the curves. A pop-up menu opens. 
2. Choose Select All in the pop-up menu. 
3. Click the button . 

 
4. The Show Simulation Result window opens. 



 109 Product Version 16.6 

 
See the following pages for more curves.  
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4.5.5.2.2 2D Curve (Eye Contour) 

 
If Both time and voltage is checked in the Analysis Options window, a new curve for the 
JN_BER_Eye will be generated and displayed as BER Eye. 

 

4.5.5.2.3 2D Curve (Bathtub) 
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4.5.5.2.4 2D Curve (Noise Bathtub) 

 

4.5.5.2.5 2D Curve (Ramp Response) 
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4.5.5.2.6 2D Curve (Impulse Response) 

 

4.5.5.2.7 2D Curve (Impulse Response) 
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4.5.5.2.8 2D Curve (Rx Waveform) 

 

4.5.5.2.9 3D Eye Density 

 

Click  to view a Top View of the eye, 
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4.5.5.2.10 3D Eye Density 

 

You can scroll the middle mouse button to zoom in and out, and you can also click  to add 
measurement cursors. 

4.6 Result Browser and 2D Curve Presentation 

4.6.1 Result Browser 
The Result Browser option is available for all the curve windows, such as 2D Curve (Time 
Variation), 2D Curve (Frequency Response), S Parameter Viewer, Jitter Tolerance, Compliance 
Curve, 3D Eye Density, and Report View.  
You can right-click in the curve panel, and choose Result Browser… from the pop-up menu to 
view the results. As shown in the following examples: 
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With this option, all the previous results under the result, history and result(bat) folders can be 
browsed and displayed from various curve windows.   

 

4.6.2 Compliance Curve Window 
1. Right-click in the Results panel, and choose Compliance Report from the pop-up menu. 
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The previous generated Compliance report will be displayed. 

 
This works for all four SLA Compliance kits. 

2. In the Curves panel, click the desired Compliance plot to view the plot. 
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4.6.3 Curve Pane Context Menu 
To display the context menu, right-click on the Curve window.  

 
You can perform the following operations in this menu. 

• Measure — Toggle the horizontal and vertical measure lines. 
• Marker — Toggle the horizontal and vertical marker lines. 
• Expression Calculator—Setup and calculation the expression. 
• Save—Save the curve. 
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• Export To Excel—Export the curve to Excel. 
• Export to Bitmap File—Export the curve to Bitmap file. 
• Black / White Background — Set the background of the curve window to be black or 

white. 
• Embed-Ctrl Visibility – Set the visibility of the sub windows (for example, the legend 

bar) in the display area. 
• Embed-Ctrl Position – Toggle the sub windows between floating and docking. 
• Ctrl Bar Position – If a sub window is docked, change the position of the docking. 
• Bar Chart — Toggle the plot style between a bar chart and a continuous line. 
• Auto Tip — Show / Hide the tip of the objects in the Curve window when moving the 

mouse. 
• Add Annotation — Add a text string in the Curve window. 

All these common items are available for 2D Curve (Time variation), 2D Curve (Frequency 
Response), Compliance Curve, and Jitter Tolerance. Each 2D Curve may have additional items 
which are unique to the specific 2D Curve window. 

4.7 Auto Archive SSI Project 
1. Choose File > Archive Project…. 

 
The Archive Project window opens. 

2. Specify Project Location and Project Name for the copied project.  

 
By default, 
• The location of the original project is selected for the copied project location 
• <original_project_name>_copy is set for the copied project name 
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3. Check the files that should be included in the copied project. 
By default, 
• The files under the original project folder and under the original sub-folders are listed and 

checked for archiving, and will be copied to the new project folder 
• The files used by the original project but located other than the original project folder are 

listed and checked, and they will be copied to a sub-folder named Ref under the new 
project folder 

• The files under the history, result, and result(bat) sub-folders are not listed 
If you want to uncheck a file used by the original project, the following message opens. 

 
4. To add additional file, click the Add File… button. 
5. To add additional folder, click the Add Folder… button. 

• The files checked and used by the original project are highlighted in blue 

 
• The files not used by the original project are not highlighted, and they can be deleted 

from the list 
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• The files are highlighted in red if they are used by the original project but does not exist 

or are un-checked 

 
 



 123 Product Version 16.6 

NOTE! If there are any files highlighted in red, the copied project will fail to simulate. 

6. Click the Archive button to generate the copied project.  
• All the checked files will be copied to the copied project  
• If the Zip Project option is checked, a zipped project file will be created. Otherwise, a 

new project folder will be created for the copied project 
The following messages may appear while archiving: 
• If no files are checked, the following message opens 

 
• If the file used by the original project does not exist, the following message opens 

 
• If the designated project folder already has the archived project folder or zipped file, the 

following messages open 

 



 124 Product Version 16.6 

 
• If the archive project process completes successfully, the following messages open 

 

 

4.8 Integration with Allegro Signal Explorer 
 
SystemSI provides a way to push a topology for a particular signal into SigXplorer for constraint 
capture. SigXplorer topologies are then used to drive electrical constraints, including the routing 
schedule, into Allegro layout. The topology database becomes an Electrical Constraint Set (ECSet) 
within the Allegro database that can be applied to one or many nets. 
To export the results of Serial Link Analysis as electrical constraints, perform the following steps.  
1. From the File menu, choose Export Constraint Topology. 

Following message box is displayed.  
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2. Select OK, to close the message box.  

SystemSI starts the export process. Once the process is complete, splash screen for Allegro 
SigXplorer appears, followed by the Product selection dialog box. 

3. Select the appropriate license and click OK. 

 
The exported topology is displayed in Allegro SigXplorer. 
 

 

NOTE! 

For projects with cross-talk topologies, before the start of the export process, the 
Export Constraint Topology dialog box is displayed. 

 
Before extracting the topology information, System SI runs AC Sweep analysis, 
which involves S parameter extraction of interconnects,  to identify the main 
channel. To continue with the extraction process, select Yes. 
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5 Compliance Kits 

This chapter lists the templates and corresponding compliance checks supported 
by SystemSI – Serial Link Analysis (SLA), for high-speed SerDes designs. Using 
compliance kits automates the compliance testing process, thus speeding up the 
design process. 
 
The topics covered in this chapter are: 

• Compliance Workflows 
• SFP+ Compliance 
• HDMI Compliance 
• PCIe Compliance 
• 10GBASE-KR Compliance 
• USB 3.0 Compliance 
• MIPI Compliance 

 

5.1 Compliance Workflows  
To view the compliance kits supported by SystemSI SLA, perform the following steps. 

1. Launch SystemSI. 
2. From the Compliance menu, choose Serial Link Analysis. 

All supported compliance kits are listed in the sub-menu. 

 
3. To display a compliance workflow, select the compliance from the sub-

menu. 
The workflow for the selected compliance is displayed.  
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5.1.1 Templates and Models 
All compliance kits supported by SystemSI include predefined ready-to-run 
templates. While these templates have models associated to each block, you can 
replace default models with custom models. You can associate custom channel 
models for interconnects and IBIS-AMI models for transmitters and receivers. 

 
Selecting a template and associating appropriate models to the template blocks are 
common tasks to be performed for all compliance kits. Depending on the 
compliance selected, you may need to perform an extra step of setting AMI 
Parameters. 

5.1.2 Compliance Checks 
After you have specified the models associated with each block, you can run the 
compliance checks.  
1. To view the list of compliance checks supported for a template, from the 

workflow, select Choose Compliance Item. 
Compliance options available for the template are listed. 
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2. You can either select all options by selecting the check box in the first 

row, or can select individual options by selecting the corresponding check 
boxes in the last column. 

 
3. Click OK to save your selections. 
4. To start the compliance checks, from the workflow, select Check 

Compliance.  
The Run Simulation dialog box is displayed.  
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• Re-characterize channel  
Select this option if the design has been modified since last simulation, 
and channel characterization needs to be done again. Selecting this 
option ensures that all modification are accounted for in the channel 
simulation results. 

• Redo frequency domain simulation 
Select this option if you want to run the frequency domain simulation 
(This is same as signal connectivity check in other Sigrity tools). This 
option has no impact on the channel simulation results, and can be 
ignored. 

5. Click OK to start the simulation. 
Once the simulation is complete, the simulation report is generated and 
displayed. 

5.1.3 Viewing Results 
As the simulation is completed, the simulation report is displayed, as shown in 
the following figure.  

 
For each of the compliance check selected by you, the reports indicates if the 
channel passed the compliance check by adding Pass or Fail against each test 
in the report. 
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Post simulations, all Simulation Results options in the workflow are enabled. 

 
 

Export Results 
Select this option to save the simulation results in the specified location. Both, simulation results 
and simulation curves, are saved. 

Show Simulation Curves 
Select this option to view the simulation results. On selecting this option, the Show Simulation 
Result dialog box displays. 

 
 Accept the default selection and click OK. 
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Simulation curves are displayed in 3 windows; 2D curves window, 3D Curves, and report. 

  
Eye Density      BER EYE  

 

 
Report View 

View Compliance Curves 
Select this option to view the compliance curves.  
Each compliance kit has unique set of compliance curves. 

 To view a compliance curve, select the appropriate curve in the Curves pane.  

 
Figure 5-1  PCIe 3 Compliance Curves 
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NOTE! For more information on compliance curve, see the sections on Compliance 
Curve Window and Curve Pane Context Menu. 

 

5.2 SFP+ Compliance 
 
SystemSI-Serial Link Analysis provides SFP+ compliance checks for cable assemblies and for 
printed circuit boards. Figure 5-2 and Figure 5-3, lists the SFP+ compliance checks available for 
cable assemblies and boards, respectively.. 

 
Figure 5-2: SFP+ Compliance Checks for Cables 
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Figure 5-3: SFP+ Compliance Tests For PCBs 

If the Waveform Distortion Penalty (dWDPc or TWDPc) check is selected, following dialog box is 
displayed: 

 
To accept the default values, click OK. 
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5.3 HDMI Compliance 
SystemSI provide compliance kit for verifying channel performance against HDMI (High 
Definition Multimedia Interface) specifications.  

 
Figure 5-4 HDMI Compliance Checks 

 

5.4 PCIe Compliance 
The PCIe compliance kit follows the PCI Express Gen 3 standard, including IBIS-
AMI models with back-channel support.  

 
Figure 5-5PCIe 3 Compliance Checks 
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Jitter Tolerance 

Most of the compliance kits included with SystemSI SLA have Jitter Tolerance included as one of 
the compliance checks. To run the Jitter Tolerance analysis in the PICe 3 workspace: 

 Select the Stressed/Swept Jitter compliance check. 
With this check selected, the compliance report includes the jitter tolerance results. 

NOTE! 
A PCIe 3 specific jitter mask is shipped with SystemSI. For PCIe 3 
compliance kit, load the Pcie3_jtolmask.txt mask file, before running 
the compliance checks. 

The generated PCIe3 compliance report includes the jitter tolerance results. 

 
 Select the Jitter link in the report, to view the jitter tolerance simulation plot. 
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5.5 10GBASE-KR Compliance 

 
Figure 5-6 10GBASE-KR Compliance Checks 

Jitter Tolerance  
To run the Jitter Tolerance analysis for 10GBASE-KR compliance, select The Interference 
Tolerance compliance check. 
With this check selected, the compliance report includes the jitter tolerance results. 

 
Selecting the Jitter_Tolerance link displays the compliance curve. 
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5.6 USB 3.0 Compliance 
SystemSI – Serial Link Analysis provides support for compliance testing process for USB 3.0 
serial links. For this, following templates are available: 

• Device Short Channel (Host compliance channels) 
• Device Long Channel (Host and Cable compliance channels) 
• Host Short Channel (Device compliance channels)  
• Host Long Channel (Device and Cable compliance channels). 

 

 
Figure 5-7USB 3.0 Compliance Checks 

Jitter Tolerance  

To run the Jitter Tolerance analysis for USB 3.0: 
 Select the Stressed/Swept Jitter compliance check. 
 Ensure that usb3_jtolmask is selected as mask file in the Jitter Tolerance dialog box. 
 Run the compliance checks. 

The generated compliance report includes the jitter tolerance results. 
 

NOTE! 
You can specify the jitter amplitude and the frequency values obtained from the 
jitter tolerance curve, in the Jitter & Noise Tab for Tx, and validate the channel 
simulation results. 
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5.7 MIPI Compliance 
The MIPI standard is targeted for short range (less than one meter) mobile applications that 
require low pin count and low power consumption. SystemSI MIPI compliance kit supports high 
speed MIPI serial links.  

 
Figure 5-8 MIPI Compliance Checks 

Jitter Tolerance  
To run the Jitter Tolerance analysis for MIPI compliance, select Stressed/Swept Jitter 
compliance check. With this check selected, the compliance report includes the jitter tolerance 
results. 
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A Appendix: Batch Mode Support 

A.1 Batch Mode Command 
1. List of the batch mode commands for the regular SystemSI – Serial Link Analysis: 
 

<ExeFileFullPath\SystemSI.exe> -b -sim <workspace file>  

\\ for the default SSI simulation  
 

<ExeFileFullPath\SystemSI.exe> -b -sim:sweep <workspace file> 

\\ for the sweep 
 

<ExeFileFullPath\SystemSI.exe> -b -sim:freq <workspace 
file>        

\\ for the frequency response 
 

<ExeFileFullPath\SystemSI.exe> -b -sim:sparam <workspace 
file>  

\\ for the S-parameter extraction 
 
Example for Windows OS: 
Path\SystemSI.exe -b –sim 
“C:\Working\SystemSI\SFPP\sfpp\sfpp.ssix” 

Path\SystemSI.exe -b -sim:sweep 
“C:\Working\SystemSI\SFPP\sfpp\sfpp.ssix” 

Path\SystemSI.exe -b -sim:freq 
“C:\Working\SystemSI\SFPP\sfpp\sfpp.ssix” 

Path\SystemSI.exe -b -sim:sparam 
“C:\Working\SystemSI\SFPP\sfpp\sfpp.ssix” 

2. List of the batch mode commands for the SystemSI – Serial Link Analysis compliance kits: 
 

<ExeFileFullPath\SystemSI.exe> -b -compliance:sfpp <workspace 
file> 

\\ for the sfpp compliance. It will generate the compliance report and export the html file to 
the default folder 

 
<ExeFileFullPath\SystemSI.exe> -b -compliance:hdmi <workspace 
file>  

\\ for the hdmi compliance. It will generate the compliance report and export the html file to 
the default folder 

 
<ExeFileFullPath\SystemSI.exe> -b -compliance:pcie3 <workspace 
file> 
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\\ for the pcie3 compliance. It will generate the compliance report and export the html file to 
the default folder 

 
<ExeFileFullPath\SystemSI.exe> -b -compliance:10gbase-kr 
<workspace file>   

\\ for the 10gbase-kr compliance. It will generate the compliance report and export the html 
file to the default folder 

 
<ExeFileFullPath\SystemSI.exe> -b -compliance:usb3 <workspace 
file> 

\\ for the USB 3.0 compliance. It will generate the compliance report and export the html file 
to the default folder 
 
Example for Windows OS: 
Path\SystemSI.exe -b -compliance:usb3 
“C:\Working\SystemSI\SFPP\sfpp\sfpp.ssix” 

 

A.2 Run a .bat file 
1. Put down the batch mode commands into a .bat file. 

Example for Windows OS: 
(sfpp.ssix: a SLA workspace) 
set systemsi=“the full path of the systemsi.exe” 

%systemsi% -b –sim “C:\Working\SystemSI\SFPP\sfpp\sfpp.ssix” 

%systemsi% -b -sim:sweep 
“C:\Working\SystemSI\SFPP\sfpp\sfpp.ssix” 

%systemsi% -b -sim:sparam 
“C:\Working\SystemSI\SFPP\sfpp\sfpp.ssix” 

%systemsi% -b -compliance:pcie3 
“C:\Working\SystemSI\SFPP\sfpp\sfpp.ssix” 

 
To run the tests simultaneously, make the following modification in the tested .bat file: 
set systemsi=start “the full path of the systemsi.exe” 

 

NOTE! Replace the red font part with the full path of SystemSI.exe file.   

2. Double-click the .bat file to run it.  

A.3 Result Folder for Batch Mode 
A new sub-folder result(bat) will be added for all batch mode results. Each batch mode 
simulation has its own sub-folder under the result(bat) folder.  
Example   
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For a SLA workspace, each common result is located in its responding sub-folder. The 
compliance result is in a folder named with the compliance type. 

 
The result(bat) folder is available from Results Browser: 

 
In Sweep Manager, all the sweep results including those in the result(bat) folder are listed 
under the Results > History tab. 
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A.4 batch_mode.log File 
If a simulation does not run or fails for any reasons, please check the batch_mode.log file located 
under the result(bat) folder. 
Error messages are added to batch_mode.log for the following failures: 
• The sweep parameter is not defined for the sweep analysis 
• The ports are not defined for the S-parameter extraction 
• The workspace does not have the fixed blocks, nodes, and MCPs pre-defined for the specified 

compliance kit 
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